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Tuesday
uesday,, January 17, 2006
SPECIAL INTEREST GROUP
(SIG) UPDATES
SIG LEADERS GIVE AN OVERVIEW OF JUST WHAT GOES ON
AT THE VARIOUS SIG MEETINGS SPONSORED BY CUG
AND HOW IT MAY BE OF INTEREST TO YOU
Presented By
Bill Ball of Windows & More, Judi Ball of DTP & Graphics, Jane Quinn of Multi-Media
One free ticket to each member at the door!
Club Business and Program Presentation 7 PM, coffee and tea available
Check at the Greeting Table for your name tag and please leave it in the Tag Box when the meeting is over.

General meetings are at the Palo Cedro Church Of Christ, 21895 St. Francis Way, Palo Cedro, CA.
Official Website: http://users.snowcrest.net/ibmpcugr
For more information call any Board member listed on Page 2.
Future Presentation:
February - Pro Show Gold Progran with Paul Colligan and Darold Wright

CUG Calendar
CUG Board Meeting
1 PM, Monday, Jan 23

at Jack-In-The-Box, Dana Drive

MULTI-MEDIA
10 AM, Saturday, Jan 21

DTP SIG
2 PM, Wednesdays
Jan 4, 11, 18, 25, Feb 1, 8

WINDOWS & MORE
11:30 AM, Wednesdays
Jan 4, 11, 18, 25, Feb 1, 8
SEE BACK PAGE FOR MORE SIG INFO
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Motherboard
Policies
The Motherboard newsletter is published
monthly by the Computer Users Group of
Redding, PO Box 494778, Redding, CA
96049-4778. The CUG is a 501(c)(3) nonprofit corporation. Subscriptions are
included in the $25 annual membership
fee. The purpose of the newsletter is to
inform members of upcoming events and
provide infor-mation about the use of IBM
compatible computers.
Disclaimer: Neither the CUG, its Officers, the Editor, nor the newsletter
contributors assume any liability for
damages occurred due to the use of
information provided in this publication.
Reprints: Articles from this newsletter
may be reprinted by other user groups if
credit is given to both the author, CUG
and the Motherboard. Mail a copy of the
newsletter where the article is reprinted
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to the Editor at the address in the first
paragraph of this text.
Personal Ads For Members:
Requirements are:
1. Advertiser must be a member.
2. The item must be computer-related.
3. The ad must be received by editor J.
Ball by the monthly date of the board
meeting. Sorry, no exceptions.
Other terms must be approved by the
club’s Board of Officers and Directors.
Article Submissions: All articles and reviews must be submitted to J. Ball by
the Monday of the monthly Board
meeting (see Page 1 for date.) Sorry, no
exceptions.
Motherboard Editor reserves the right
to make corrections and deletions in all
articles in the interest of grammar, style,
and space.
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President’s Message

It’s your club. Your input is of value to us…

I got my first computer in 1981, a 1.25
kilobyte (yes, I said, kilobyte) SinclairTimex. It was also the first computer I
had ever seen. I was a teacher then, and
other classes were actually coming to
my classroom to see this technological
marvel in action. My son and I were jubilant when we were able to upgrade to a16
kb. I hope that I am as creative with my
current computer as I was with that one.
Today, of course, you can go into a primary classroom and see more computer
power than was needed to send an American to the moon. My five year old granddaughter plays checkers with me on a
video conferencing link. I do most of my
shopping on the net. I Instant Message
friends who are missionaries on an island
off the coast of Africa. I operate a Website
for persons with my diet sensitivities,
make money even when I am on vacation, and have customers from countries
I have never heard of.
What does all this have to do with my
new role as president? I’ll find out as the
year progresses, but I do know that I love
computing and that I do not need to apologize for the fact that I was born into a
world that is totally different from what I
experience today. I can’t pick up computing skills by osmosis the way my grandchildren are doing. But, with help from my
friends (that’s you) I think we can all enjoy
the twenty-first century.
Thanks for entrusting me with the
presidency of this
club!
Paul Colligan

Editor’s Corner
Monthly meeting time and date are
being discussed and opinions polled
throughout the membership. It will be
addressed during the 1/17 meeting with
members present. Please let us know
what you prefer.
Don’t miss our new Surfboard on Page
5! Mary Montague has taken on the
challenge and it looks great. She would
appreciate any feedback you might
have.
See you at the meeting,
Judi Ball
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Our Christmas Party

Alisha (11) & Tyler (14), Parks agreed to
be our “Santas” this year. They are
member, Ethel Martin’s grandchildren
and they were so delightful and
sweet! Please come
back anytime.

Thanks to Bill Ball and Larry Owings “The Camera Guys!”
They did a fine job of capturing our party in the absense of
our club’s unofficial photograher Anna Lee Horton.

Thank you, Alisha!

Thank you, Tyler!

Party pictures continued on Page 6
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Multi Media S
S..I.G. Update

Welcome Renewals
Bill & Judi Ball
Dale Inman
Donna Whitlock
Elaine Blanco
Eugenia Goodman
James Hughes
Josie Cozens
Marge Stewart
Patricia Larsen
Phil Graham
Robin Snyder
Rolland Henry
IBM/ PCUG
MEMBER WEBSITES
DAVE & BECKY HEMP
www.c-zone.net/dochemp/

JACK MCAULIFFE
Real Estate Broker
www.realtyphoto.com

KITTYSTONE PERSIANS
Lynn Johanson
kittystone.com

MEXICAN-TOURS
www.mexican-tours.com
Lyle VanNorman
lyle@mexican-tours.com

EnvironmentalMold.com
lyle@EnvironmentalMold.com
Informational site for air Quality.

QUESTIONED DOCUMENT EXAMINATION
Mary Ann Czermak
www.documents-examiner.com

RIVERCITY JAZZ SOCIETY
Joyce Covey
jazzjoy@charter.net

REDDING REAL ESTATE
Rick Goates

www.reddingrealestate.net
RON COLE JR.

www.houseofspecialtygifts.com
Publicize Your WebSite
Here for FREE!
(Members Only Please)
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by Jane Quinn

MULTI MEDIA S.I.G.
This past month we have collectively been working to create DVD movies from
our still images and captured video footage. Our goal was to either make a movie
to E-mail or a DVD home movie to watch with the family.
With the club’s new laptop our S.I.G. can create DVD disc for its members at the
meetings. All that one needs to bring to the session is his completed project. For
example, using MS MovieMaker ver 2.0 (which is free) the Movie project would have
the image stills, or the video footage laid out in the proper sequence, music files
added for effect and audio files if used for narration. The file that is produced by MovieMaker from the project can be recognized and read by other DVD authoring software
to produce a DVD movie.The club’s laptop has several DVD authoring software products
installed that work well with many audio stream files, like WMAs from MovieMaker.
Our startling discovery this month was that you can buy a camcorder with proprietary software, meaning some of your favorite software may not recognize your
new camera! In this situation the new Panasonic camcorder had a conflict with the
Roxio software that was already on the computer. The camera’s software would
not download the movie clips off the camera. It would only display an error message
saying the application software was already in use. We went to the company’s
Website and found a statement that the camera could have problems with third
party software. My Sony camcorder is as temperamental as the Panasonic camcorder. It too only recognizes the software that comes with the Sony camcorder.
To overcome the camcorder problem the user removed the Roxio software,
and voila! the clips were recognized by the Panasonic software. He was also able
to download the movie clips to his computer. Our next task is to determine if the
Roxio software, which the user knows, can be reinstalled without causing a conflict.
We will tell you next month just what happens.

TIPS
TERMINOLOGY
I thought it might be useful to start introducing the terms we are using in our S.I.G.
The great thing about making home movies is the terminology being repeated in all
the applications. So once you understand the process of making movies, using
Roxio DVD Builder, or MS PhotoStory 3, you can quickly recognize the same steps
are required in DVDit 6 by Sonic.

CAPTURE
This refers to activities related to bringing in still pictures and movie files from
sources such as disks, cameras connected directly to your computer, and existing
media, as would be the case in selecting and saving a single frame from a movie
file. Capturing is also a term used to refer in the recording of sound, from audio CDs
or through a microphone, as well as moving images via a video camera connected
directly to your computer.

PROJECT
A project contains the arrangement and timing information of audio and video
clips (source files), video transitions, video effects, and titles you have added to
the storyboard/timeline.

SOURCE FILES
Once movies, still pictures, and sounds are captured, they become the source files
of the Project. In most programs they appear as thumbnails. These thumbnail images
are only a representation of the actual physical location of that file in your computer.

STORYBOARD
The storyboard is used to look at the sequence or ordering of the clips in your
project and easily rearrange them, if necessary. This view also lets you see any
video effects or video transitions that have been added. You can also preview all of
the clips in your current project. Audio clips that you have added to a project are not
displayed on the storyboard; however, they are displayed in the timeline.

TRANSITION
The point at which one movie scene ends and another one begins is called a
transition.
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The Surf boar
d
board

by Mary Montague, twinsgranny228@aol.com
I, for one, have really missed Dorothy Kirk’s Surfboard column, and I feel certain that others have
also. I won’t presume to try to fill her shoes, but I would like to offer something along that line that
I hope might keep the idea alive, at least. In this first attempt to provide a sampling of websites, I
thought that the subject of charities might be interesting, since we have all been bombarded with requests from
one charity after another, especially during the recent “giving” season. And I am equally sure that we all wonder from time
to time whether the plea for money comes from a legitimate organization or from a source that is at best merely wellmeaning but inefficient or at worst a downright fraud. I have left off the http://www designation, because that can be taken
for granted, and at least in my case is supplied by my computer when I type in the name of the website.
give.org
This site brings you the BBB Wise Giving Alliance, a reporting agency which collects and dispenses information on approximately
500 charities. This organization also rates them on a number of criteria including percentages of their income allocated to
administration, fund raising, actual expenditures, etc. Select the charity you are interested in for facts and evaluations, and you
will find an abundance of information including ways in which they may not measure up to certain clearly stated standards of
accountability. For example, it may point out that the CEO may also be on the Board of Directors, which is apparently not a
desirable factor in the opinion of this organization.You will find the name and salary of the CEO (makes me want to start my own
charity), where their funds come from, and how they are dispersed. I found this site very helpful and forthright.
activistcash.com
Although not strictly a site about charities, it does cover fund-raising organizations and foundations which purport to
promote worthy causes and which are actively soliciting your donations. This site, a project of the Center for Consumer
Freedom, in their words, “provides the public with in-depth profiles of anti-consumer activist groups, along with information
about their exorbitant funding.” It describes their fund-raising and propaganda tactics, including in some cases even
threats of violence, and offers information about their backers, including many celebrities that might surprise you. Links
include activist groups, foundations, celebrities and key players. Want some hair-curling updates on the Sierra Club or the
Humane Society of the United States, check this out. You may also find interesting the numerous instances of how many
of the activist organizations have evolved, often starting out with altruistic and commendable goals and morphing into
quasi-terrorist groups or having goals far different and managed by far different people (MADD, Sierra Club et. al.). This
site makes for provocative reading, if nothing else.

Bits and Pieces
by Rush Blodget; IMB/PCUG of Redding, rblodget@snowcrest.net

CONFIGURING TEXT SO THAT IT CAN BE SEEN ON
SCREEN BUT NOT PRINT
You can select all or part of a Microsoft Word document
so that the highlighted text can be seen on screen, but
won’t print. To do this it is necessary to go to the Format
Menu, click on Font and then check the box entitled Hidden
under Effects. The highlighted text will disappear from the
screen and will not print if an attempt is made to print it. To
bring it back on the screen one must now go to Options in
the Tools menu, and check the box titled Hidden in the
Formatting marks area of the View tab. The text will now
reappear on the screen, but will not print. I tried this and it does work, however, it
leaves a faint series of dots on the screen underlying the hidden words. I have at
times found Internet sites that would not print (presumably copyrighted material).
The preceding was abstracted from the tips section of PC Magazine.

MORE NEW DOMAIN NAMES
At a recent world summit meeting the U.S. again won the right to assign domainname extensions. This task will remain in the hands of the Internet Corporation for
Assigned Names and Numbers – known as Icann. In 2000 biz and info were added.
Since then several more were added including jobs and travel. The extension post
is awaiting approval. Not yet having seen these extensions I searched for them
with Google (using www.*.the extension) and found that they do exist. This
information appeared in the Wall Street Journal for November 17, 2005.
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Put Y
our Computer
Your
To Work By Using The
Evaluations/
Review
Evaluations/Review
Program!

Don’t forget to check out the Evaluations Program offered by this organization! If there is an application you
would like to have, put your request in
to Jane Quinn and she will contact the
company/vendor to see if the product is
available for review. If it is, she will order
it for you.
This could be a new program to you,
or it could be the newest version of a
program you already know.
When it comes in, Jane will let you
know, and you will have at least three
months to install the program, learn to
use its most prominent features, then
write a review that will be published in
this newsletter and sent to the company
to complete their requirements.
Evaluations Person, Jane Quinn
qjquinn@charter.net
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Windows Recovery or Restore Disks:
Problems and Alternatives
by Vic Laurie, Princeton PCUG, New Jersey, victor@vlaur.com
Once upon a time you received a copy
of a full Windows installation disk when
you bought a computer. This allowed you
to reinstall individual system files or
Windows components if anything went
wrong. But no longer. These days the best
you can hope for from many vendors is
a so-called “recovery” or “restore” disk”.
And many major vendors do not even
provide that much. Instead they put stuff
on a hidden partition on the hard drive.
This is all the backup that you get, and if
the hard drive crashes, the hidden
partition goes too. Then you have no way
of reinstalling Windows on a replacement
hard drive without getting a disk from the
original PC vendor. From what I read on
the Web, this last process can take some
time and effort, if you succeed at all. If
you are out of the warrantee period, you
may be completely out of luck.
Some vendors may provide a Windows
disk when you buy a PC if they are prodded hard enough. However, there may be
some kind of “handling and shipping” fee.
Note that, if you do finally get a disk, it
will probably be an OEM (original equipment manufacturer) version and may lack
some features of a full-fledged version.
Also OEM versions of Windows are often
not eligible for upgrades.
The failure to provide an actual
Windows installation disk with new
computers is convenient for Microsoft
and the computer vendors but can be a
real problem for the PC user. There are
many problems that can be fixed by
copying a single system file or reinstalling
small portions of the Windows operating
system. Without an installation disk, PC
users need to have some other source
for these files. If you put a recovery disk
into your CD drive, it will want to reformat
your hard drive and reinstall an image of
your computer that is a replica of the
way your system was on the day you
bought it. Any changes that you have
made will be wiped out. All those
programs you installed, all those
Microsoft patches, XP SP2, all of it will
be gone. The same thing applies when
you restore from one of those hidden
partitions.

Page 6

Therefore, an alternative is needed.
At the very least, a source of files for
adding and removing Windows components and restoring corrupted files should
be available. Sometimes the vendor will
have put the Windows installation files in
the root of your hard drive or in the
Windows folder. In Windows XP look for a
folder named “I386” (without the quotes).
If you do have one of these folders, burn
a copy to a CD for backup. This CD will
not have all the functions of an installation
CD since it will not auto-run nor will it boot.
However, reinstallation can be initiated by
clicking the file Winnt32.exe (assuming
that you can get your system to boot). If
you have a FAT32 disk and can use DOS,
Winnt.exe is the appropriate file to access
from a DOS boot disk.
A problem is that you will have a disk
that lacks any of the multitudes of
patches and updates that will have come
out since you bought your computer.
Therefore, you need to “slipstream” with
the XP SP2 update. Slipstreaming is a
way of merging updates with the original
files so that everything is updated. This
is not a quick job but it is worth doing.
An excellent detailed step-by-step
procedure is given at the Elder Geek site.
If you can borrow a Windows XP
installation disk (almost any version will
do) you can extract the image that is
needed to make the CD bootable and add
that to the disk. Details for using common
CD burning software to do all this is given
at the reference cited above.
One more problem can be getting the
Windows XP product key for your
system. It may be pasted or written
somewhere in the documentation that
came with your computer. Be sure to
make a permanent record of it. If you
cannot find the product key, there are
several free applications that will retrieve
it from your system. One is ViewKeyXp
and is available here. Another is
Keyfinder, which is available here. Also,
system information applications like
Belarc Adviser can reveal the key.
At the end, you will still have something
that provides backup only for the Windows
operating system. Since I want to be able
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The Gift List
As door prize coordinator, I wish to
thank the following folks for taking an
afternoon to help me wrap the fortysome gifts you see laid out on the table
below.
Bernice Bennett, Joy Garcia, Margaret Martinovich, Marge Stewart,
Margot Letendre, Tony Church. More
folks volunteered than we were able to
put to work. I want to thank you all,
and I appreciate your thoughtfulness.
Judi Ball

THE GIFT LIST INCLUDED:
5 (10-Pk) DVDs & Cases
3 Belkin Surge Protectors
2 Cordless Phones
2 Air Dusters
1 Mug & Coffee Warmer
1 Box Cherry Cordials
2 Book Lamps
1 Disk Cleaner, battery powered
1 Retractable USB Cord
3 CD Wallets
5 T-Shirts
10 10-pks Slim Jewel Cases
5 5-pack Slim Jewel Cases
1 Greeting Card Factory Program
1 Ocean Aquariam Screen Saver
2 Paper Reams
to restore everything, including software
that I have installed, I prefer to spend a
few dollars and use disk imaging software.
It makes keeping up-to-date backups on
CDs or other external media very easy.
Norton Ghost, BootIt Next Generation or
Acronis True Image are all reasonable
choices.
The Editorial Committee of the
Association of Personal Computer User
Groups (APCUG), an international
organization of which this group is a
member, brings this article to you.
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Our Christmas Party Continued
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Tips for Locating Misplaced Files
by Dave Gerber, APCUG Advisor, Region 5; Dave’s Bits & Bytes, A Periodic Newsletter for the Members of the Sarasota PC User
Group and the World! director, Sarasota PCUG, Florida (dave_bytes@comcast.net), www.spcug.org/http://davebytes.com/
Losing files on your PC is a lot like
misplacing your car keys in a cluttered
apartment.You know the things you’re looking for are close by, but actually finding
and using them can be a challenge.
Unlike your apartment, though, Windows has a helpful feature that can locate
wayward items and save you a good deal
of frustration. In Windows 95/98 (Win9x),
this feature is called Find. In Windows
XP and Windows Me, it’s called Search.
There are also third-party programs that
can ensure that you never have to endure
the loss of an important file again.
In this article, we’ll show you one of
the more popular ways to find lost files
and some techniques to keep you from
losing files in the future. We’ll start by
covering the Find feature in Win9x. The
WinMe and WinXP version of this feature
is significantly different and warrants a
separate explanation. Note, however, that
many of the tips included in the Win9x
section apply to later versions, so don’t
skip ahead.

FIND IT IN WINDOWS 95 & 98
There are two fast ways to access the
Find feature in Win9x. One method is to
click Start, point to Find, and click Files
or Folders. Shortcut keys also work for
this feature; press Windows-F to display
the search program instantly. If you’re
certain a file is in a specific folder, don’t
use the Find feature from the Start menu;
a faster way is to press the F3 key in
Win9x (or CTRL-F in WinMe) when you’re
already at the right folder window or have
the folder displayed in Windows Explorer.
This will display the search window
already set to search the current folder.
Whatever technique you use to launch
the Find utility, you end up with a dialog
box named Find All Files. It has five menu
options: File, Edit, View, Options, and
Help. The Name & Location tab is the
most commonly used area of the Find
command, as it includes the Named and
Look In text boxes. Win98 also has a
Containing Text text box listed here. (In
Win95 this option is on the Advanced
tab.) If you know the name of the file you
want to locate, just type it in the Named
text box, make sure the Look In path is
directed at the correct drive location, and
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click Find Now. You’ll know the search
has started because the magnifying glass
icon begins to move in circles. When the
search is complete, matches appear in
the results window. This window shows
all relevant information about the file, such
as file name, type, size, location, and date
modified. Remember that you don’t have
to let a search complete its examination;
click the Stop button to bring things to an
immediate halt. This is especially useful
when you accidentally start a search over
a gargantuan hard drive that takes several
minutes to inspect. There are many variables that can help you narrow your
searches and save time. If you’re fairly
certain of the folder in which a file is
hiding, click Browse on the Name &
Location tab and specify the correct folder.
On the other hand, you might not have a
clue as to which folder to look in; in that
case click the Include Subfolders checkbox to investigate a folder hierarchy from
top to bottom. In all Windows versions,
there are some other options that let you
control the search. The Date and
Advanced tabs in Win9x let you find files
by type and size. The Containing Text text
box lets you constrain results to those
with specific phrases in them. In Win9x
an Include Subfolders option lets you
widen your search. (In WinMe click
Advanced Options, which lets you Search
Subfolders or look for file names using
the Case Sensitive option.)
Search Windows Me & Windows XP
WinMe and WinXP have their own
version of the Find command, called
Search. To get started click Start, point
to Search and click For Files Or Folders,
or press Windows-F. You will see a
Search Results dialog box that’s laid out
like a Web browser, complete with Back
and Forward buttons.
In WinMe type the name of the file you
need in the Search For Files or Folders
Named text box. The Containing Text
option is listed just below, as are the
various search options, such as Date,
Type, Size, and Advanced Options, all
of which work similarly to Win9x.
In WinXP you will need to select the
type of file you are looking for before you
can begin a search. We recommend
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selecting the All Files And Folders option
because it will search your entire hard
drive for the file. If that takes too long,
the other options, such as Pictures, Music,
or Video, will narrow the search parameters
and likely make the search more efficient.
Once you’ve outlined the parameters
of your search, click Search Now or
Search. After Windows completes a
search, you can press F3 or CTRL-F to
alternately shrink and enlarge the Search
Results window, providing more (or less)
information about selected files on the
left side of the screen.
Both operating systems have useful
extras on the left side the Search Results
window, including image file preview. In
the past when you wanted to know what
was in a mysterious graphics file (usually
with a file name extension such as .JPG,
.BMP, or .TIF), you had to open the file
with a separate program, which takes
time. With WinXP and WinMe, you can
use the Preview function instead. Just
click the file, and a tiny version of the
image appears in the Search Results
area. To see thumbnails in WinXP, from
the View menu, click Thumbnails to make
image thumbnails appear.
If it takes too much time to complete
searches, you may want to streamline
the search process in WinXP by using
the Indexing Service feature. With this
feature, your computer will maintain an
up-to-date list of the files on your hard
drive, which makes subsequent filename
searches much faster.
To use the Indexing Service, in the
Search Results window, click Change
Preferences in the left pane. Click With
Indexing Service and then click the Yes,
Enable Indexing Service radio button.
Click OK, and your PC will run the service
when the computer is sitting idle.
Find files with dates. If you don’t find
your files with an initial search or WinXP
index searches, you might want to search
for files by date. In Win9x from the Start
menu, point to Find and then click Files
Or Folders. In the Named Or text box,
type *.xls (or *.doc, or whatever file type
you most often use). Click the Date Or
Continued on Page 9, Column 1
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MISPLACED FILES
From Page 8
Date Modified tab and click Find All Files
Created Or Modified. Click the During
The Previous option and then adjust the
number of days you’d like this search to
work for. (A week is probably a good
starting point.)
You can do this in WinMe by clicking
the Date checkbox. Select Files Modified,
Files Created, or Files Last Accessed
from the drop-down menu. Then click the
In The Last option, followed by the number
of days you want the search to cover.
In WinXP after you click All Files And
Folders, you can enter part of the file
name and then click When Was It
Modified? to narrow your search to a
range of dates. You can also use What
Size Is It? and More Advanced Options
to make searches more specific; you can
even include hidden files in the search if
you prefer. After you set the parameters
in your OS, run the search by clicking
Find Now, Search Now, or Search.
Windows Me’s Search feature works
like the Find option in previous Windows
versions but has some extra power
under the hood.

SAVING A SEARCH
Once your PC completes its file hunt,
you may want to save your search
settings to reduce the amount of data
entry you have to complete for your next
complex search. After a search ends,
from the File menu, click Save Search.
This saves a shortcut on the Windows
Desktop or a folder of your choice with a
name that refers to the search. When you
want to do a speedy search for commonly
accessed documents, just double-click
the shortcut and the search parameters
will load automatically.
Win9x will also let you keep the results
of searches, plus the parameters that
created those results. From the Options
menu, click Save Results. To create a
shortcut to these results, click Save
Search from the File menu.
More search options. More archaic
computer skills also sometimes come
in handy for searches, the best example
of which is the use of older DOS
commands to aid your search. The
easiest to use is probably the asterisk
symbol. It acts like a wildcard, standing
in for at least one character in the name
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of the file or folder you want. For
instance, if you know you want to find a
file that ends in .INF but aren’t sure what
the first part of the file name is, you’d
type *.INF, which instructs the search
utility to display every file ending in .INF.
The question mark is also useful; unlike
the asterisk, it replaces only one character
in a name. For example, entering
Sysfile?.DOC would find every file with
one character following the Sysfile name
that ends with .DOC. The search variable
can also be used together in flexible
combinations. For example, enter *dos?.*
to locate file names with any filename
extension and that start with any number
of characters, following by “dos,” and then
any single character.
Searching by file type is another useful
parameter. Select this option, and you’ll
see dozens of file types from which to
choose. The best thing about this option
is that file types aren’t displayed with
cryptic extensions. Instead, there’s a
short description of the type (an AOL
email, for instance).
The Editorial Committee of the
Association of Personal Computer User
Groups (APCUG), an international
organization of which this group is a
member, brings this article to you.

How T
o Recor
d Y
our
To
Record
Your
Cassette Music T
o
To
A CD!
by Bob Elgines, CRCC Editor,
elginesz@rraz.net
Most of the equipment you already have
includes the Soundboard and a Cassette
player. Next, of course, things needed are
a recording program, such as Musicmatch
Jukebox, and a cable to connect your
cassette player with your computer. This
basic Jukebox software is available free
at, www.music match.com (go to JUKEBOX tab and click on Free Jukebox
download, it is over 24 MB in size). The
cable is made up of 1/8” Phone Plugs
(RS 274-284c) and a three wire shielded
cable. This cable can be purchased or
made on your own. (Some of the older
cassette players will use a larger ¼”
Phone plug.)
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Now we are ready to set up your computer and programs. Connect your cable
between the Output (might be labeled
Headset) of your Cassette Player and the
Line in of your computer Sound board.
Do a right click on your Speaker icon
located on the right hand side of the task
bar. Select (or left click) Adjust Audio
Properties, click on Audio. Under Sound
Recording click on Volume. Select Line
in and set the input level at approximately
20%, this may have to be changed later,
so you can leave this on the screen if
you wish.
Next activate Musicmatch Jukebox,
then go to Options/Recorder/Settings.
Set Recording Format to WAV, Recording
Source to LINE IN. Now click on
Advance, set Fadeout to 1, and under
End of Record Notifications uncheck
Play sound & Eject CD. Click Okay.
On the bottom left click the red Record button. Another window appears
with a number one on the right. You can
click on here and change the name now
or do it later. If you are going to record
the complete side of the cassette under
one file then name it now, otherwise if
you are going to record one track (or
song) at a time then you can change
the name later.
Now play your cassette to check out
the input level for no distortion listening
to it on your computer speakers. If it is
too loud and there is distortion then
reduce the input level or the volume out
of the player. Rewind the cassette.
We are ready to roll. Start your player
and press the Record button on the
lower left window. When the song is over
press the Stop button, then press
Record again because the next song
will start within a second or two. Then
press Stop, continue this until each
song is recorded from the cassette.
Now we have them in the computer,
let’s name each one, but keep the names
short. Use Windows Explorer and go to
My Documents/My Music/ Artist/Album.
Here you will find your recordings and you
can rename them by doing a right click
on each one. After you are finished, exit,
go to your CD recording program, such
as EZ CD Creator or Nero. Now you can
grab all of the recordings you made and
make an AUDIO CD. (Do not record any
Continued on Page 10, Column 3
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Ram & Reason: A Virus and Incident Checklist
by Rob Rice, Member of the Computer Club of Oklahoma City
Much has been said about virus and
malicious software prevention, but what
if all of your precautions fail? So there
you are, happily clicking along the Internet
when suddenly a popup ad obstructs your
view.You start to close it and then another
and then another pops up so that in just
a few seconds there are so many popup ads that you cannot possibly close
them all as they just keep coming. So
what do you? Delete them as fast as you
can in hopes that they will stop? Turn off
the computer? Suddenly a program
appears from nowhere and informs you
that you have been infected with a trojan
virus and the program needs to scan your
system so that the trojan can be
removed. The problem is that you do not
remember ever having installed this
program. Do you trust it?
There are some industry-accepted
procedures for dealing with this type of
incident and any virus or trojan infection.
Just follow these five simple steps in
the following order to minimize damage:
1. Do not turn off your computer unless
you are certain that your files are
being actively deleted!
2. Disconnect the network cable from
your computer and/or turn off your
wireless connection.
3. Write down any error messages and
the names of any programs or software that was running at the time the
infection occurred.
4. Mark the computer “Do Not Use.”
5. Run any of your applications that you
are certain are yours and that might
have opened identifying a virus attack.
Next, run your antivirus, anti-trojan tools.

sectors contaminated, hard drive
partitions erased, registries corrupted.
For example, on a Windows system
every time you make a major system
change one of the first things that it wants
you to do is reboot, “To allow the changes
to take affect.” In the case of a virus or
trojan, the last thing we want to do is to
allow the changes to take affect.

STEP ONE:

STEP FIVE:

Do not turn off your computer. Not
every trojan and virus is the same so
this rule will have exceptions, but generally you do not want to turn off the
computer unless you can see that the
virus is deleting your files. If you think
that it can be stopped from deleting your
files without turning off the computer, then
this is a better option than turning off the
computer. The reason is that while turning
the computer off will temporarily stop the
damage more harm can come when you
turn the computer back on. System files
can be infected when loading, boot

Run any of your applications that you
are certain are yours and that might
have opened to identify a virus attack.
Next, run your antivirus anti-trojan tools.
It’s possible that your antivirus or antitrojan software may have detected the
attack and started running a system scan
or is prompting you and waiting for
instructions. If you are certain that it is
your software then let it do what it wants
to do and let it clean the system. If you
have any doubts as to whether the
program is in fact one of your programs
then DO NOT RUN THE SOFTWARE!
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STEP TWO:
Disconnect the network cable from your
computer and/or turn off your wireless
connection. Trojans are designed to open
a door and let other trojans, spyware and
viruses in. Physically disconnecting its
link to the Internet stops this behavior,
prevents your personnel information from
going out and prevents other machines
from being infected. Many checklists
have this action rated number one and
for good reasons. I rate it here as step
two because step one is simply a quick
decision that can have a significant
impact on the recovery outcome.

Some trojans actually install and run
a program pretending to be antivirus/
antitro-jan software and scan your
system all the while claiming to be
cleaning your computer. In reality it is
part of the trojan. Some of these
programs look very commercial and very
polished so be careful!
Rob Rice is a computer specialist
working in Anchorage, Alaska. Rob can
be contacted at articles@isp.com.

The Editorial Committee of the Association of Personal Computer User Groups
(APCUG), an international organization of
which this group is a member, brings this
article to you.

CASSETTE TO CDS
Continued From Page 9

STEP THREE:
Write down any error messages that
appear and the names of any programs
or software that was running at the time
the infection occurred. This is important
not only for repairing the system but also
for identifying which alerts are real and
which ones are bogus. Error messages
that contain misspellings and poor
grammar are likely bogus and generated
by the virus.

STEP FOUR:
Mark the computer “Do Not Use.” This
is in case you get called away and have
to leave the system alone for any length
of time.
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faster than 8X, because most players will
not accepted anything faster).
Another method can be used by using
MP3 sound files. If you convert from
WAV to MP3 files, you can put up to
150 (or more) songs on a CD instead of
just 15.
To convert the WAV files bring up your
Jukebox program. Go to File/Convert,
then select your Source folder that
contains your music files. Select Source
Data Type and set to WAV, then click on
Select all. Next select your Destination
folder and select your Destination Data
Type setting it to MP3. Click on the start
button and it will now make MP3 files
out of your selected WAV files.
After you are finished, Exit, go to your
CD recording program and record your
MP3 files on a CD as data files (do not
make an audio CD), this MP3-Data CD
will now play in a DVD Player or
computer capable of having over 150
songs.

The Editorial Committee of the
Association of Personal Computer User
Groups (APCUG), an international
organization of which this group is a
member, brings this article to you.
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Motherboar
d Newsletter Contributor
s…
Motherboard
Contributors…
Our local contributors help tremendously to pay for the functioning
of our club. As club members please
do what you can to support their businesses.
Visit or call their businesses, be a patron if possible,
and tell them you saw their business card in the club’s newsletter.

Ink Jet Specialties
Suppliers of
Inkjet and Laser Cartridges, Refill Kits
Ribbons, bulk Ink & Accessories
Inkjet Refilling Service

Ed LeBouef

907 Hartnell
Redding, CA 96002
(530) 243-4INK

Fax (419) 735-9063
Order Line 1-866-243-4INK

(530) 243-4465

www.inkjetspecialties.com EdL@inkjetspecialties.com

Andy Main

Crown Camera
“Northern California’s Finest and First Internet Provider”

UNLIMITED INTERNET ACCESS
Starting at $15/month!
DSL & Wireless Access, Web Design
& Hosting Services
www.snowcrest.net
(530) 245-4698 / (530) 926-6888

Imaging Experts

Repair all makes & models
of personal computers.
! Repair monitors & printers
! Repair all types of computer
related equipment
! Sell IBM compatible
computer systems.

WE… !

Digital Cameras
Photo & Printer Supplies
1365 Market Street
M-F 8:30 - 5:30
Sat. 9 - 5
Redding, CA 96001
Phone: 530-243-8333 or 800-655-4256
FAX: 530-243-4978

www.shasta.com andy@shasta.com
5309 Chestnut St.
(530) 357-3200
(530) 224-6866
FAX (530) 224-2035
Anderson, CA 96007
3025Ricketts
Bechelli
Lane, Suite 3 Redding,
www.com-pair-svcs.com
Fax: (530) CA
357-3803
Curtis
96002

IBMPC Users Group Of Redding
Membership Application
Name(s): _____________________________________________________
Address: _____________________________________________________
City:________________________________ State: _________ Zip: _______
Home Phone: __________________ Business Phone: ______________ ___
E-mail Address: ________________________________________ _____ __
Date: __________

$25.00
DUES PER
YEAR
New
Renewal
Cash
Check

MAIL TO: IBM/PC Users Group of Redding,
P.O. Box 494778, Redding, CA 96049

(For general information call any Officer or Director listed on Page 2)

Not A Renewal Reminder
The Latest On DVDs
by Bob Elgines, Colorado River Computer Club Editor, Lake Havasu, AZ
The DVD world is going crazy. The price
range is from $59 to $130 well within most
of our budgets. DVD blanks are down to 50
cents a piece, almost as cheap as CDs. The
top four recorder manufacturers are Plextor,
Toshiba, Pacific Digital, and Memorex.
Speed is up to 16X, which is max on the
outer part of the disk, but only 8X blanks
are readily available.
Dual layer (8.5 GB of data space) is
labeled as the latest big deal, but is it really?
These disks are hard to manufacture and
are very expensive. The most important
thing is, what will they play in? Well not
much of anything. Most DVD players will
not recognize the format and neither will
your older recorders. So I don’t look for this
to do anyone much good even in the future.
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What is in the future (next year)? The
digital world has still been undecided on
DVD-R and DVD+R formats, so most of
your recorders will do both. Now we come
to the future of introducing two new formats
named “HD-DVD” and “Blu-ray.” These
new formats have been developed to use
the new blue-laser, where as, they have
been using the red-laser in our present
recorders. Red laser single level DVDs
have 4.7 GB of capacity where the Bluelaser single layer DVDs will have a
capacity of 15 (HD-DVD format) to 25 GB
(Blu-ray format) at present.
A HD (High Definition) two hour movie
uses about 17.4 GB with out max compression. The compression schemes
(MPEG-2, MPEG4, etc.) will be the same
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for both, so there will be no big difference
in playback quality. Here we go again,
new DVD players will be needed and this
reminds us of the old video tape war on
formats “Beta” and “VHS.” Remember
VHS won out due to more recording time
and lower costs. Will this be true of the
two blue-laser formats? Only time will tell.
These Blue-laser recorders and players
will be coming out near the end of this
year or the start of next year, but I think we
are going to have to wait and see if they
can decide on a format for the blue-laser.
The Editorial Committee of the Association of Personal Computer User
Groups (APCUG), an international
organization of which this group is a
member, brings this article to you.
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Why Join A
Computer Club
?
Club?
1. Benefit from a common interest in a
personal (and costly) investment: Your
business or personal computer.
2. Enjoy more of that investment by learning
more about it.
3. Share tips and tricks, as well as new
and old ideas.
4. Become exposed to a variety of new
hardware and software without sales
pressure.
5. Receive an informative monthly newsletter.
6. Have access to various club func-tions
and all Special Interest Groups (SIGs).
7. Find out that no one needs to be
alone and helpless with today’s computer
technology.

Multi-Media
SIG

IBM/PC Users Group of Redding
P.O. Box 494778
Redding, CA 96049-4778

CUG’S MEETING PLACE

Palo Cedro Church Of Christ
21895 St. Francis Way
Way..

Includes Digital Cameras, Burning Music
CDs, and Creating
QuickTime Movies.
Saturday — 10 AM
Jan. 21
Call Jane for directions to
new winter meeting place.
Jane Quinn 365-0825
qjquinn@charter.net

Windows
&
More
SIG

DTP &
Graphics
Art SIG

Wednesday — 11:30 AM
Jan 4, 11, 18, 25
Feb 1, 8

Wednesday — 2 PM
Jan 4, 11, 18, 25
Feb 1, 8
See map to left for meeting
place.

Judi Ball 275-4632
jebed@charter.net

Bill Ball 275-4632
bcard9@charter.net
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